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How to create a list of installed programson
Windows

Reinstalling the Windows operating system is one of the great solutions to troubleshoot problems on your
computer. However, before reinstalling Windows, you should save the list of programs and applications you
have installed to reinstall the applications and programs on the new operating system.

Reinstalling the Windows operating system is one of the great solutions to troubleshoot problems on your
computer. However, before reinstalling Windows, you should save the list of programs and applications you
have installed to reinstall the applications and programs on the new operating system.

Create alist of applications, installation programs on Windows that help users to reinstall those applications on
new operating systems or new computers.

In the article below, Network Administrator will show you how to create a list of installed programs on
Windows 7/8/ 8.1/ 10.

Waysto createalist of installed programs on Windows

1. 1. Usethe PowerShell command
2. 2. Use CCleaner

1. Convert thelist of installed programs into atable in Word

2. Convert thelist of installed programs into an Excel spreadsheet
3. 3. Use Command Prompt
4. 4. Use Control Panel
5. 5. Use Geek Uninstaller
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1. Use the Power Shell command

PowerShell is one of the most useful commands built into the Windows operating system. To create a list of
applications and programs installed on Windows operating systems using the PowerShell command, follow the
steps below:

First open PowerShell by typing power shell in the Search box on the Start Menu, then choose PowerShell.
On the PowerShell window, enter the following command and press Enter:

Get-ItemProperty HKLM: SoftwareWow6432NodeM icr osoftWindowsCurrentVersionUninstall * | Select-
Object DisplayName, DisplayVersion, Publisher, InstallDate | Format-Table - AutoSize

Now PowerShell will display a list of all applications, the program you installed, including the version, app
developer name, and even the application installation date.

If you want to export a file, you can send the output using the > icon and add the path to the new text file you
want to create.

Such as:;

Get-lItemProperty HKLM: SoftwareWow6432NodeMicrosoftWindowsCurrentVersionUninstall * | Select-Object
DisplayName, DisplayVersion, Publisher, InstallDate | Format-Table  —AutoSize> C:
UserslL oriDocumentsl nstalledPrograms-PS.txt
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2. Use CCleaner

Previously known users of CCleaner are applications to free up computer space, delete temporary files, files that
users don't use, personal data on the browser, download history and lists. programs on some other applications.

Many users do not know that CCleaner is also an application used to create lists of programs and applications
installed on Windows operating systems.

To use to create a list of applications, installation programs on Windows using CCleaner, first double-click the
CCleaner application icon on the Desktop or right-click the Recycle Binicon, select Open CCleaner. .

Import into PhraseExpress
Empty Recycle Bin

Open CCleaner...

Run CCleaner lk

Pin to Start

Create shortcut

Rename

Properties

« Pinform CCleaner
F Windows
'e Microsoft Edge

Cleaner

CCleaner Free o 05
V5 i) ) CPU @ 2.40GHz, 16.0GB RAM, Intel HD Graphics 4600

Applications

an :
[ ] ] inload History

Temporary Internet Files
+ History

v Cookies

+ Recently Typed URLs
+ Index.dat files

Options

Here you select Uninstall. On the Uninstall interface, you will see alist of applications and programsinstalled on
your computer. Y ou can use CCleaner to remove, repair, rename or delete these programs.

Also you can save the list of installed programs on the Text file by clicking Save to text file in the lower right
corner of the interface.
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Save to text file... k‘

On the Save As dialog window, navigate to the location where you want to save the text file containing the list

of applications, installed programs on your computer, then name the file in the File name box and then click
Save.

After completing:
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List of installed programs on your Windows computer including application installation date, application size,
program, application version .



] InstalledPrograms-CCleaner.tet - Notepad

File Edit Format View Help
1Password 4.6.0.684 AgileBits 2/29/16 28.6 MB 4.8 63
3D Builder Microsoft Corporation 12/14/15 18.1€
7-Zip 9.20 (x64 edition) Igor Pavlov 8/16/15 4.85 MB 9.20.
ABoards for Trello AB DEV 3/4/16 1.2.1.0
Adobe Acrobat Reader DC Adobe Systems Incorporated 3/18/16 379 M
Adobe Flash Player 21 NPAPI Adobe Systems Incorporated 3/25/
Alarms & Clock Microsoft Corporation 3/28/16 18.1683.1282¢
App connector Microsoft Corporation 11/13/15 1.3.2
Apple Application Support (32-bit) Apple Inc. 4/7/16 117 ¥
Apple Application Support (64-bit) Apple Inc. 4/7/16 131 PV
Apple Mobile Device Support Apple Inc. 4/7/16 28.3 MB 9.3.¢
Apple Software Update Apple Inc. 4/7/16 2.69 MB 2.2.8.156
Bonjour Apple Inc. 4/7/16 2.85 MB 3.1.8.1
Box Box, Inc 1/26/16 2.8.5.8
Brother MFL-Pro Suite MFC-8816DW Brother Industries, Ltd.

W
< >

Convert thelist of installed programsinto atablein Word

To convert the list into atable in Word, open the saved text file in Word. A dialog box called File Conversion is
displayed before the file is opened, to et you preview the text in the Preview box, accept the default settings and
click OK .

Select the encoding that makes your document readable,
Text encoding:

O Windows [Default) O MS5-DOS @ Other encoding: | Turkish [DOS) -~
Turkish (150)
Turkish [Mac)
Turkish (Windows)

Ukrainian (Mac]
_ W

Preview:
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Select the text you want to convert into a table, then, on the Insert tab, click Table and select Convert Text to
Table.
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Make sure the column number is 5 and select Tabs in Separate text at , then click OK to continue the
conversion.



Table size
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Mumber of rows:
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You can format the table the way you want, but remember to save this Word file on an externa hard drive or
network drive so you can use it when installing or resetting Windows.

1. 4 waysto reset the Windows computer to its original state
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Convert thelist of installed programsinto an Excel spreadsheet

If you want to convert the list of installed programs in Excel, here's how. First

, you should create a copy of the

original text file so that in the event of an error, you still have the original file to use. Next step is to convert this

copy from .txt to .cvs and open the .cvsfile with Excel.

1. How to open CSV file when Microsoft Excel is not installed

On the first screen of the Text Import Wizard dialog box, make sure to select Delimited in Choose the file
typethat best Print your data . The rest, you can leave the default settings and click Next .

The Text Wizard has determined that your data is Delimited.

If this is correct, choose Mext, or choose the data type that best describes your data.
Criginal data type
Choose the file type that best describes your data:

: () Fixed width

Start import at row: |1

- Characters such as commas or tabs separate each field.

- Fields are aligned in columns with spaces between each field.

File grigin: | Windows [&NSI)

-
=4

|:| My data has headers,

Preview of file Ci\Users\LoritDocumentsiInstalledProgramsiinstalledProgramsCC.csv,
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Cancel
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On the second screen, select Tab in Delimiters, you can skip the third step because we only need to convert the
fileinto a spreadsheet in Excel so click Finish here.

This screen lets you set the delimiters your data contains. You can see how your text is affected in the
preview below,
Delimiters
[ Tab
[ semicolon |:| Treat consecutive delimiters as one
Dgomma . |
Text gualifier: |~ ~
[1space .
DQ’ther:
Data preview
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Now, the list of installed programs in columns on Excel spreadsheetsis easier to read. Be sure to save the Excel
fileto an external hard drive or to a network drive to be accessible when reinstalling or resetting Windows.
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3. Use Command Prompt

If you are more familiar with using traditional Command Prompt than PowerShell, you can use the Windows
Management | nstrumentation Command command line (WMIC) in the Command Prompt window.

1. 21 Command Prompt tricks you may not know



Press Win + R key combination to open the Run dialog box, then type " cmd.exe " in the Open box and click
OK or pressEnter . If the User Account Control dialog box is displayed, click Yesto continue.

-“'
..’..
i BN | aaloeilanls

=7  Typethename of a program, folder, document, or Internet
= resource, and Windows will open it for you.

Open: cr‘r‘ld.E:-:EI h r
K E Cancel Browse...

At Command Prompt, type " wmic " and press Enter . Enter the following line at the prompt pmic: rootcli and
press Enter . Replace the path and filename part (¢ C:

User sL oriDocumentsl nstalledPr ogramsl nstalledProgramsWM I C.txt ') with the path and file name you want
to use:

/output: C: UsersLoriDocuments! nstalledProgramsl nstalledProgramsWMI C.txt product get name, version

When receiving the WMIC prompt : rootcli , type ' exit ' and press Enter to return to the normal command
prompt. Type' exit ' again and press Enter to close the Command Prompt window.

The text file has the name and version of the programs installed on the computer created and saved in the
location you specified.
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4. Use Control Panel

If you do not want to type the command to create a list of installed programs, there is another method you can
use to see all theinstallation programs on the Programs and Featur es screen in Control Panel.

Type' control panel ' into the Sear ch box next to the Start menu, then click Control Panel under Best match .

Best match

Control Panel [} @

Desktop app
Apps
1 Settings
Search suggestions

L control panel - see wet

O control pane| (2)

On the Control Panel window, click Uninstall a program in Programs. If you are viewing small or large icon
mode, click item Programs and Features.
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To view the details of each program in the list on the Uninstall or change a program screen , click the More
options arrow on the Change Your View button and select Details .

Click on thetitle bar of the Control Panel window to make sure it works, then press Alt + Print Screen (or Alt +
Fn + Print Screen on some laptops or other devices) to take screen shots picture of the window.

1. Computer screen capture software without software, super fast for Win 10, Win 8/8.1, Win 7

anel + Programs * Programs and Features ~ @  Search Programs and Features 0
Uninstall or change a program
To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.
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Paste a screenshot into another program like Paint and save the image. In Paint, you can save screenshots in
PNG, JPEG, BMP, GIF or other formats.

Depending on the number of programs installed, you may receive a number of different shots. Scroll down each
section to capture the next part of the list. If there are multiple photos, you can paste each image directly into a
word processor like Word to save themin afile.
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5. Use Geek Uninstaller

Geek Uninstaller is a free Windows portable program used to completely remove programs. The program also
strongly removes stubborn and corrupted software. You can use Geek Uninstaller to create and save a list of
installed programs on your computer.

After downloading Geek Uninstaller, you just need to extract the downloaded file into afolder on your computer
and run the exe file. On the main window of Geek Uninstaller, you will see alist of installed programs. To save
thislist to an HTML file, open Geek Unistaller and go to File> Export toHTML or press Ctrl + S.

1. How to export Chrome browsing history to HTML, CSV or TXT file

On the Save As dialog box, navigate to the folder you want to save and enter the name and then click Save.
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The HTML file will automatically open in the default browser. The list includes the name and capacity of each
program and the date it was installed.

If you use a browser like Firefox, Chrome or Vivaldi, press Ctrl + S to save the HTML Instaled Programs
page to the location you choose with the optional file name. Y ou can save it on your computer's hard drive but
remember to transfer this file to an external hard drive or to a network drive before reinstalling Windows. Each
browser will have a shortcut or a different option to save the HTML file, so be aware.
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Program Name Size Installed On

1Password & 14.3MB 02.01.2018 00:00

7-Zip 9.20 (x64 edition) 4.37 MB 10.07.2015 00:00
AutoHotkey 1.1.24.04 17.12.2016 00:04
Belarc Advisor 8.6a 5.73MB 16.04.2018 14:12
Bersirc 2.2.14 475KB 18.01.2017 18:14
CCleaner 33.7MB 16.04.2018 13:23
CleanMyPC version 1.8.4.779 39.7MB 03.05.2017 00:00
Dropbox 517 MB 13.04.2018 14:53
Foxit Cloud 6,66 MB 10.07.2015 00:00

| Foxit Reader 133MB 10.07.201500:00 ¥

Geek Uninstaller also allows you to display alist of applications installed from the Windows Store by going to

View> Windows Store Apps.




File Action | View Help
Program Mam % Desktop Apps Siz alled On "
@ 1Passwor  Windows Store Apps [\ MB  Jan02,2018 |
7-Zip 9.2 Interface Language r | 437 MB Jul 10, 2013
la) AutoHott o0 £5 Dec 17, 2016
Belarc Advisor 8.6 0011 573 MB Apr 16, 2018
ﬂ Bersirc 2.2.14 (32-bif) 475 KB lan 18, 2017
s CCleaner 33.7MB Apr1g, 2018
EA CleanMyPC version 1.8.4.779 39.7 MB May 03, 2017
%2 Dropbox (32-bit) 517 MB Apr13, 2018
@ Foxit Cloud [32-bif) 6.66 MB Jul 10, 2015
E Foxit Reader (22-bit) 133 MB Jul 10, 2015
& GIMP 2.8.18 282 MB Jan 23, 2017
|=} GO Contact Sync Mod (37-bit) 783 MB Mar 10, 2017
€ Google Chrome 22-6if] T MB Jan 21, 2017
@ Grammar{j!} tor Microsoft® Office Suite 234 MB Jan 02, 2018
m Kernel for Outlook to! PDE ver 13.07.61 11.2 MB Jan 02, 2018
G LibreOffice 5.2.4.2 (32-bit) 428 MB Jan 01, 2017
on Melloware PlacesBar Editor (52-0if) B89 KB Jan 09, 2017
I Microsoft Office 365 - en-us 239 GB Apr 16, 2018
& Microsoft OneDrive 100 MB Apri3, 2018
£3 Mirrnenft Vienal Ca s 3010 vAA Bedictrih 124 MRE Mo M8 20TA »
Type to find a program
39 programs of 1.01 GB size in total i Upgrade to PRO version

All applications installed on your computer from the Windows Store screen can be exported to HTML files in
the same way, as with normal Windows programs.



File = Action View Help

|_ Exportto HTML... bﬂtl‘h—ﬂ' ﬂ Installed On £

[ Bt 26.1 MB Apr 10, 2018

I -ﬂ Alarms & Clock .02 MB Apr13, 2018
E App connector 44.0KB Mov 08, 2016
E App Installer 2.36 MB Mow 20, 2017
L3 Baconit 29.1 ME Jan 09, 2018
Calculator 5.23 MB Apr 10, 2018
£l calendar Apr 10, 2018
E Camera 643 MB Apr 10, 2018
n Email Insights 26.6 MB Dec 29, 2017
E Feedback Hub 42.8 MB Apr 10, 2018
EI Food & Drink 234 ME MNov 08, 2016
Q’ Get Help 7.63 MB Apr 10, 2018
g’ Groove Music 56.1 MB Mar 07, 2018
ﬂ Health & Fitness 28.6 MB MNov 08, 2016
=] mail Apr 10, 2018
E Mail and Calendar Accounts 215 MB Apr 10, 2018
E! Maps 19.8 MB Mar 07, 2018
D Messaging 287MB Mar 07, 2018
E Microsoft Pay 4.66 MB Jan 24, 2018

| E tdicrnenft Snlitaire Crllactinn (29 bt 57T A MR Anr 1R 018 »

Type to find a program
36 programs of unknown size in total Upgrade to PRO version

Storethelist of applications created on external media

You may have noticed that the above methods create different program lists, so you can use one or more
methods and keep separate lists.

However, one thing to keep in mind isto save thislist on an external hard drive or network drive so that it can be
used after reinstalling Windows. When you reset instead of reinstalling Windows 10, the programs will be
deleted but its data remains. However, you should still back up your list when backing up your data.

1. How to use the Reset feature on Windows 10
Refer to some of the following articles:
1. Instructions for setting up and managing FTP Server on Windows 10
1. Instructions for setting up and managing Network Bridge on Windows 10
1. How to use Cortanato turn off or restart Windows 10?

Good luck!



Y ou finished reading the article "How to create a list of installed programson Windows" edited by the
TipsM ake team. We hope this article has provided you with many useful tech tips and tricks. Y ou can search for
similar articles on tips and guides. Thank you for reading and for following us regularly.
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